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Preface 

The National Curriculum Framework, 2005, recommends that children’s life at 
school must be linked to their life outside the school. This principle makes a 

departure from the legacy of bookish learning which continues to shape our 

system and causes a gap between the school, home, community and the 

workplace. 

The student workbook on “Spreadsheet (Basic)” is a part of the qualification 
package developed for the implementation of National Vocational Education 

Qualification Framework (NVEQF), an initiative of Ministry of Human Resource 

Development (MHRD), Government of India to set common principles and 

guidelines for a nationally recognized qualification system covering Schools, 

Vocational Education and Training Institutions, Technical Education Institutions, 

Colleges and Universities. It is envisaged that the NVEQF will promote 

transparency of qualifications, cross-sectoral learning, student-centred learning 

and facilitate learner’s mobility between different qualifications, thus 
encouraging lifelong learning. 

This student workbook, which forms a part of vocational qualification package 

for student’s who have passed Class VIII or equivalent examination, was created 

by a group of experts. The IT-ITeS Skill Development Council approved by the 

National Skill Development Corporation (NSDC) for the IT/ITeS Industry 

developed the National Occupation Standards (NOS). The National Occupation 

Standards are a set of competency standards and guidelines endorsed by the 

representatives of IT Industry for recognizing and assessing skills and knowledge 

needed to perform effectively in the workplace. 

The Pandit Sunderlal Sharma Central Institute of Vocational Education 

(PSSCIVE), a constituent of National Council of Educational Research and 

Training (NCERT) in association with Wadhwani Foundation has developed 

modular curricula and learning materials (Units) for the vocational qualification 

package in IT/ITes sector for NVEQ levels 1 to 4; level 1 is equivalent to Class 

IX. Based on NOS, occupation related core competencies (knowledge, skills, and 

abilities) were identified for development of curricula and learning modules 

(Units). 

This student workbook attempts to discourage rote learning and to bring about 

necessary flexibility in offering of courses, necessary for breaking the sharp 

boundaries between different subject areas. The workbook attempts to 

enhance these endeavour by giving higher priority and space to opportunities 

for contemplation and wondering, discussion in small groups and activities 

requiring hands-on-experience. We hope these measures will take us 
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significantly further in the direction of a child-centred system of education 

outlined in the National Policy of Education (1986). The success of this effort 

depends on the steps that school Principals and Teachers will take to encourage 

children to reflect their own learning and to pursue imaginative and on-the-job 

activities and questions. Participation of learners in skill development exercises 

and inculcation of values and creativity is possible if we involve children as 

participants in learning, and not as receiver of information. These aims imply 

considerable change in school routines and mode of functioning. Flexibility in 

the daily time-table would be a necessity to maintain the rigour in 

implementing the activities and the required number of teaching days will have 

to be increased for teaching and training. 
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About Your Workbook 

This workbook is to assist you with completing the Unit of Competency IT105-
NQ2012: Spreadsheet (Basic). You should work through the workbook in the 
classroom, at the workplace or in your own time under the guidance and 
supervision of your teacher or trainer. 

This workbook contains sessions which will help you to acquire relevant 
knowledge and skills (soft and hard) on various aspects of the unit of 
competency. Each session is small enough to be easily tackled and digested by 
you before you move on to the next session. Animated pictures and 
photographs have been included to bring about visual appeal and to make the 
text lively and interactive for you. You can also try to create your own 
illustrations using your imagination or taking the help of your teacher. Let us 
now see what the sections in the sessions have for you. 

Section1: Introduction 

This section introduces you to the topic of the Unit. It also tells you what you 
will learn through the various sessions covered in the Unit. 

Section 2: Relevant Knowledge 

This section provides you with the relevant information on the topic (s) covered 
in the session. The knowledge developed through this section will enable you to 
perform certain activities. You should read through the information to develop 
an understanding on the various aspects of the topic before you complete the 
exercise (s). 

Section 3: Exercise 

Each session has exercises, which you should complete on time. You will 
perform the activities in the classroom, at home or at the workplace. The 
activities included in this section will help you to develop necessary knowledge, 
skills and attitude that you need for becoming competent in performing the 
tasks at workplace. The activities should be done under the supervision of your 
teacher or trainer who will guide you in completing the tasks and also provide 
feedback to you for improving your performance. To achieve this, prepare a 
timetable in consultation with your teacher or trainer and strictly adhere to the 
stipulated norms or standards. Do not hesitate to ask your teacher or trainer to 
explain anything that you do not understand. 

Section 4: Assessment 

The review questions included in this section will help you to check your 
progress. You must be able to answer all the questions before you proceed to 
the next session. 

At the end of the Unit, there is a list of learning resources which include books, 
journals, newsletters, websites, etc. to support your further learning. 
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SESSION 1: INTRODUCTION TO SPREADSHEETS 

Have you seen your father or mother keep track of family expenditure in a 

diary? How do they keep track of the expenditure? Have you noticed how they 

calculate the total, categorise similar types of items, prioritize expenses and 

also track the changes in expenses from month to month. A spreadsheet is an 

electronic document, very much like the way your parents maintain an expense 

sheet in a diary. 

RELEVANT KNOWLEDGE 

The term spreadsheet was derived from a large piece of paper that accountants 

used for business finances. The accountant would spread information like costs, 

payments, taxes, income etc., out on a single, big, oversized sheet of paper to 

get a complete financial overview. 

A spreadsheet provides much more flexibility, speed and accuracy, as 

compared to a manual expense sheet. It also has many features and functions 

built into it making it easy to use. For example, if you change one amount, the 

total is recalculated automatically. Spreadsheets are used for a variety of 

tasks, such as 

 Maintaining records 

 Analysing data 

 Creating MIS (Management Information System) reports 

 Generating graphs (for pictorial representation of data) 

 Doing financial calculations 

 Managing inventory 

 Budgeting etc. 

Some of the most popular spreadsheet software are: 

 MS-Excel 

 Open Office – Calc 
 Google Documents 

Getting started with Spreadsheet: 

To start you can choose any of the above software to start creating a 

Spreadsheet. You may start learning to use Spreadsheet with either the 

Openoffice – Calc or Microsoft-Excel. Make sure that this software is already 

installed in your computer. You can start using MS-Excel software, by 

performing any one of the following steps: 
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a) Double Click on a shortcut key of the MS-Excel icon, if available, on the 

desktop 

OR 

b) Click [1] Start [2] All Programs [3]Microsoft office[4]Microsoft 

Office Excel 

If you are using any other spreadsheet software, the steps to start it would be 

almost identical to what is given above. 

Once you start the MS-Excel, the following screen would be displayed. The 

components of the screen displayed are shown in Figure 1. 

Cell 
Formula Bar Active Cell Column N Address 

Row 15 

Horizontal Scroll 
Sheet Tab Bar 

Ribbon 

Vertical 
Scroll Bar 

View 
Buttons 

Figure 1: Components of a MS-Excel Spreadsheet 
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Some of the key components of a spreadsheet are: 

 Worksheet: This is a grid of horizontal rows and vertical columns. 

 Workbook: A workbook contains one or more worksheets. 

 Figure 1 has three worksheets, each named Sheet1, Sheet2 and Sheet3. 

The Sheet Tab is pointing to Sheet2. The current sheet shown in Figure 1 

is Sheet1. 

 Row: A row is a horizontal arrangement of cells. The rows are named by 

numbers (1, 2, 3, 4,…). In Figure 1the arrow points to Row 15. 

 Columns: A column is a vertical arrangement of cells. The columns are 

named by alphabets (A, B, C, ….., Y, Z, AA, AB, AC, …., AZ, BA, ….). In 
Figure 1 the arrow points to Column N. 

 Cell: A Cell is where the rows and columns intersect. Worksheet is also 

called an array of cells. A cell may contain text, number, date or a 

formula. A cell is the fundamental element of a worksheet. This is where 

numbers/text are entered. A cell address in a spreadsheet identifies 

location of the cell. It is a combination of column name and row number 

of the cell, such as A2 or B16 etc. 

Note: When identifying a cell by its address, the column name is always 

listed first followed by row number. 

 

 

Active Cell: This is the cell on which the cursor is currently placed. It is 

outlined by a dark border. Data is always entered in the active cell. In 

Figure 1 the Active Cell is H7. 

Formula Bar: This is located below the Ribbon. It displays the contents of 

the active cell. It can also be used to enter and edit data. 

 Scroll Bar: These helps to scroll through the content and body of the 

worksheet. There are two scroll bars – horizontal and vertical. 

When an OpenOffice-Calc spreadsheet is opened, it looks like Figure 2 

shown below. Notice that the look and feel of MS-Excel and OpenOffice-Cal 

spreadsheet is quite similar. Also observe differences in the icons on the 

Ribbons. Most of the spreadsheet software have similar functions and 

features, with minor differences in the way, the tabs, icons, dialogue boxes 

and functions are arranged. If you learn to use one, it is fairly easy to use 

any other similar software. 
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Figure 2: Components of an OpenOffice-Calc Spreadsheet 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1. Identify the key components of spreadsheet 

2. Open a spreadsheet 

11 



 

 

       

             

          

          
      

 

             

           

        

            

       

 

         

 

         

       

       

      

  

    

        

      

   

      

 

               

             

    

            

 

 

        

    

          

              

           

 

    

Page L;ivaut F-, 

E:alibri • ) 11 

~ Copy• I Paste 
Format Painter 

Oipboanl r. 

B I !! • 

Font 

B7 · ( 
A B C D 

1 

2 He llo World 

3 

4 423 

5 

5 15-AUj:l-47 

7 I I 
~ 

8 

9 

10 

SESSION 2: OPEN, SAVE AND CLOSE SPREADSHEET 

Let us start with understanding how to create a spreadsheet and save it for 

later use.To begin with, let us create a simple spreadsheet. Before creating the 

spreadsheet, create a folder “D:\IT Class IX\WP_Practice” where you shall store 
all the spreadsheets that you create. 

RELEVANT KNOWLEDGE 

a) Open: Start the spreadsheet as learnt in the previous exercise. When you 

create a spreadsheet, a default name is given by the software. MS-Excel 

names it Book1, whereas OpenOffice names it as Untitled1. 

a. When a new spreadsheet is opened in MS-Excel, the sheet tab usually 

has three worksheets – Sheet1, Sheet2 and Sheet3. 

b) Enter the data shown in Figure -3in the 

spreadsheet. 

a. To go to cell B2, move cursor to the 

cell and then left click the mouse. Now 

type the word Hello World and press 

enter key. You would notice that after 

pressing enter, automatically cell B3 

becomes the active cell. 

b. You can move to cell B4 by using down 

arrow key of keyboard and type 423 

and press enter. 

c. Similarly enter 15-Aug-1947 in cell B6. 

c) Save this workbook and give it the name First. To do so, the steps are the 

same as the ones you used for saving a document file in a MS-Word. To 

quickly review the steps again: 

o In the Quick Access bar, click the symbol for the floppy 

OR 

1. Click the [1] File  [2] Save. 

2. A Save As dialog box appears. 

3. Choose the Directory (Drive and Folder) by clicking on the one 

that you want in the list shown on the left hand side. You will see 

the path on the D:\IT Class IX\WP_Practice displayed as you select 

the path. 

Figure -3: Entering Data 
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4. Enter the name which you would like to give to this document in 

the File name box. For example, you can give the name First to 

this file. 

5. Click Save. 

a. This workbook will be saved in MS-Excel with the name First.xlsx. The 

first part is the name given to this file and .xlsx is the extension 

name for any worksheet created under MS-Excel. 

b. Similarly if you are using OpenOffice, the file will get saved with the 

name First.ods. OpenOffice gives an extension name of .ods to a 

spreadsheet file. 

d) Close: Now you can close this spreadsheet by following one of the sets of 

commands given below: 

a. Click on the cross symbol “X”, that you see on the top right hand 
corner of the screen. 

OR 

b. Click [1] File  [2] Close. 

e) Open: Now re-open the above spreadsheet; make some more changes to it. 

Write the names of your class mates in rows B7 to B12, and save it with a 

different name. 

f) Save: Having made further changes, you need to save the changes. You can 

save it with the same name First.xlsx, in which case the older file saved 

earlier will get overwritten by the changes which you made. Alternatively, 

you may like to keep the earlier file First.xlsx as it is, and save this 

modified spreadsheet using a new file name, e.g. Second.xlsx. To save it 

with the same name, just follow the steps explained earlier. To save it with 

a different name, use the following steps: 

a. Click the [1] File  [2] Save As 

b. A Save As dialog box appears. Choose the Directory (Drive and Folder) 

by clicking on the one that you want in the list shown on the left 

hand side. You will see the path on the D:\IT Class IX\WP_Practice 

displayed as you select the path. 

c. Enter the file name which you would like to give to this document. 

For example, you may give the name Second to this file. 

d. Click Save 
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Now this spreadsheet would be saved in MS-Excel with the name Second.xlsx. 

g) Close: You can close this document by following one of the sets of 

commands given below: 

o Click on the symbol of cross “X”, which you see on the top right hand 
corner of the screen 

OR 

o Click [1] File  [2] Close 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Open a spreadsheet 

2 Save a spreadsheet with an appropriate name 

3 Close a spreadsheet 

To practice concepts learnt, repeat the above steps by opening a new 

spreadsheet, write the names of 10 of your classmates with their roll numbers 

and save the sheet. 
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A B C D E F G 

1 

2 

3 Name Roll No. Dat e of Bi rth 

4 Rav i Kaul 23 13-Aug-9,9 

5 Bijender Dalal 13 15-Jan-9,91 

6 Radha Sw am i 7 02-Jan-OO 

7 Vikas Maheshwari 32 17- Nov-98 

8 Vi ml,a Rani 14 23-Se p~9,9, 

9 Sa ndhya Reddy 2!6 l 9LDec-98 

10 

SESSION 3: ENTER DATA IN SPREADSHEET 

Spreadsheets enable us to work with different kinds of data for organizing, 

calculating and presenting information. We will start by entering data in a 

spreadsheet. 

RELEVANT KNOWLEDGE 

Open a new spreadsheet and enter the data as shown in Figure. 

Figure 4: Different data types 

Observe three different kinds of data you have entered in the above 

spreadsheet. These are: 

 Text: The names of the students are treated as Text type of data. 

 Number: The roll numbers are treated as Number type of data. 

 Date: The date of birth is treated as Date type of data (notice the entry 

in the formula bar when a cell with a date entry is active). 

There is another kind of data which you can enter, which is called Formula. You 

will learn about this a little later. You can also observe that text data is 

automatically aligned to the left in a cell, the Number data is aligned to right 

and the Date data is also right aligned. 

Note: You can do calculations using a Number, Date and Formula type of data, 

but you cannot do calculations using Text data (also referred as alpha numeric 

data). 

 Now save this workbook file by giving it a name and close it. 
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EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Make a list of five of your friends with their name, phone number and 

date of birth. 

2 Save the spreadsheet with an appropriate name 

3 Close the spreadsheet 

Additional Practice Exercises: 

1. Open the workbook. Click on the tab Sheet2. You would see that a blank 

worksheet appears on the screen. If you click again on tab for Sheet1, the 

data you had entered earlier would appear. Why? Because these are separate 

sheets in the same workbook; just like pages on your notebook. 
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A B C D E F G H 

1 

2 S.No . Nam e Erigli slil Hi nd i M aths Scieri oe Tot al 
-

3 1 Ablil as 39, 76 93 91 349 
-

4 2 Anita 9,2 82 98 91 363 

5 3 Raj a 95 81 76 82 334 

6 4 Subbu 84 72 99, 9·4 349, 

7 5 Priya 94 9,3 100 97 384 

8 6 Gautam 78 39, ,59, nl 3081 
� 

·9, 

SESSION 4: BASIC CALCULATIONS – ADDITION 

A spreadsheet helps you do many mathematical calculations – e.g. addition. 

RELEVANT KNOWLEDGE 

Open a new spreadsheet and enter the data as shown in Figure 4. 

Figure 4: Adding Marks 

Now to total the marks of each of the students, do the following: 

 Go to cell G3. In the cell G3 enter: +c3+d3+e3+f3 and press Enter. 

o The total marks of Abhas appear in cell G3. 

o In a similar way, we calculate the total marks of Anita. 

 In cell G5 enter: =sum(C5.F5)and then press Enter. 

o This is another way of entering a formula for addition, when the cells to 

be added are adjacent to each other. C5 is the address of the starting 

cell and F5 is the address of the last cell.C5.F5 is also called a Range of 

cells. 

o In a similar way, calculate the total marks of Subbu, Priya and Gautam. 

o You have totaled the marks by entering formula in two different ways. 

The cell does not display the formula, but it displays result of the 

calculation i.e. the total marks in the above example. When G7 is made 

the active cell, you will see formula displayed in formula bar (just below 

the Ribbon). 

Now change marks of one of the students in one or more subjects. The total 

marks of that student will get calculated automatically. Automatic calculation 

of formulas is one of the most powerful features of electronic spreadsheets. 
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F)

A 

1 

2 Ro~N o 

3 Name 

4 

5 
S111bject 

5 faili 
7 English 

8 Physic_s 

9 Chemistry 
10 Compmer Sc 

11 

12 

13 

B C D 

Mark Sheet 

Practical Theory 

Tota] Marks 

Total Percentage 

Remarks 

Marks 

Tota] 

E F 

Maxinmm 
11_ Percentage 

Mari<.s 

G 

Pass / 

Fail 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Create a list of all your personal expenses made during the month and 

calculate the total expenses 

2 Create a list of names of the month and holidays in that month. Add 

and calculate the total number of holidays in a year. 

Additional Practice Exercise 

Design a mark sheet for a student as shown in figure below: 

Mark Sheet 

a) Calculate percentage of marks in each subject. 

b) Calculate total marks and total percentage. 

c) Depending on the total percentage write the following in remarks 

 Excellent – 90% or more 

 Very Good - 80%-less than 90%, 

 Good - 70%- less than 80%, 

 Fair - 60%-less than 70%, 

 Poor – less than 60% 

d) Use cell style to show colored cells 

e) Use thick outline border 

Use Font size, color and alignment for the text. 
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A B C D E F G H 

1 

2 S. No. Nam e Engli sh Hind i M aths Science Tot al 
-

3 1 Abhas 89' 76 93 91 349, 

4 2 An ita 912 82 98 91 363 

5 3 Raja 9'5 81 76 82 334 

6 4 Subbu 84 72 99, 9·4 349, 
-

7 5 Priya 94 9,3 100 97 384 

8 6 Gautam 78 89' ,69, nl 3081 
� 

9 

A B C D E 

1 

2 Month Income, Expense Saving 
-

3 Janu ary 10,000 8,500 1,500 

4 Febru ary 12,600 9,100 3,500 

5 March 7,900 8,700 
-

6 April l!0, 11100 10,000 

7 May 1L 250 8,S.23 

8 June 12,'900 14,200 

9 

SESSION 5: BASIC CALCULATIONS – SUBTRACTION 

RELEVANT KNOWLEDGE 

Another math operation that can be done using the spreadsheet is subtraction. 

Figure -5: Adding Marks 
Open new spreadsheet and enter data as shown in Figure 6. 

Figure 6: Subtraction 

Now to calculate savings in each month: 

o Go to cell E3. Enter: +C3-D3<Enter>. Note that as you are entering the 
formulae in the cell E3, the cells C3 and D3 automatically get 

highlighted. The savings for January will be displayed in cell E3.Now 

calculate savings for February. 
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Insert Page Layout Formulas Data 

Calibri 

Paste I B I - Format Painter 

01pboan::I r.. 

BIO 

A B C D E 

1 

2 Month Income Exp.,nse Saving 

3 January 10,000 8,500 1,500 

_4 · F~bruary 12, 6D0_ 9,_Ioo_ 3,soo_ 

5 March 7,900 8,700 

_ 6 April 10,600 10,000 

7 May 11,250 8,523 

8 June 12,900 14,200 

9 

A B C D E 

1 

2 Month Income Expense Saving 

3 Janu ary 10,000 8,500 1,5'00 

4 Fe bru ary 1 2, 600 9,,100 3,500 

5 M arch 7, 9 00 8, 700 -800 

6 April 10, 600 10,000 600 

7 M ay 11, 250 8,523 2, 727 
g Jun e 1 2, 900 14,200 - 1,300 

9 July 12,500 10,200 

10 A ug u st 1 3,000 11,500 

11 Se pt e m b er 14,000 1 2, 100 

12 Octob e r 11,200 1 2,500 

13 N ove m b e r 11,100 11, 300 

14 Dece m b e r 11, 9 00 11,400 

1.S 

You would observe that you have been 

entering formula one by one in each cell. In 

a spreadsheet, you can copy a formula 

entered in one cell to many other cells, 

where you need to do exactly the same 

calculation. This feature of a spreadsheet is 

called copying formula. To do so: 

o Go to cell E3. 

o While in the Home Tab, click on the 

icon for Copy. 

o Go to cell E5 and click on the icon 
for Paste. 

o The formula gets automatically pasted in the cell E5. You can also 

observe in the Formula Bar that the address of the cells referred to in 

the formula automatically changes when Copy – Paste function is used. 

Now Copy the formula in other cells for calculating savings for April, May and 

June. 

There is an alternate and easier way to paste formula: Copy – Click and Drag – 
Paste. The method of Copy-Paste formula which you just learnt can become 

very time consuming, if the same formula has to be pasted in large number of 

cells, say one hundred cells. Spreadsheet has a faster way of Pasting the 

formula that you have copied. 

In the same worksheet add six more records for the months July to December. 

Enter data for Income and Expense. The spreadsheet will look like Figure -8. 

Figure 7: Copy - Paste 

Figure -8: Subtraction 

20 



 

 

    

            

     

 

     

      

    

   

      

   

      

      

    

    

   

   

              

         

 

  
      

 

 

            

       

 

 

 

 

 

 

 

 

 

  

1.

A B C D E 

1 

2 Month Income, Expense Saving 

3 January 10,000 8,500 1,500 

4 February 12, 500 9,100 3,500 

5 March 7, 900 8, 700 -800 

6 April 10, 500 10,000 500 

7 May 11, 250 8,523 2, 727 

8 J1J 111 e 12,900 14, 200 -1,300 

9 JtJ ly 12,500 10, 200! I 
� 

10 August 13,000 11,500 

11 Sept ember 14,000 12, :wo 

12 October 11, WO 12,500 

13 November 11,100 11, 300 

14 Deoember 11, 900 11,400 

15 

I I 

 Do the following steps: 

o Take cursor to cell E8. Copy formula, as you did earlier. You will see 

that the box around cell E8 

starts blinking. 

o Observe that the blinking 
box in cell E8 has a small 

dark rectangle in the 

bottom right hand corner. 

o Take the cursor over this 
rectangle. The cursor will 

take the shape of +. Now 

click the left button of your 

mouse and drag the cursor 

with your mouse, while 

keeping the left button 

pressed, and drag the 

cursor up to cell E14. Now release the left button. You will see that the 

formula has been automatically pasted to the entire range specified. 

Figure-9: Drag and Copy 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 In the above worksheet calculate the total savings across the twelve 

months and display the result in cell E15. 
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L 
1 

2 

L 3 

- 4 

5 

- 6 

- 7 

8 

- 9 
-, 

8 

9 

10 

11 

12 

13 

14 

15 

A 

S.N o. 

B 

Nam e 

1 Abh as 

2 Anita 

3 Raja 

4 Subbu 

5 Priya 

r6 Gautam 

b AOOb 

7 A007 

8 A008 

9 A009 

10 AOlO 

C D 

Engli sh Hind i 

89 76 

912 82 

9'5 81 

84 72 

94 9,3 

78 891 

Cieometry tlox 

Set of 6 sket ch pens 

Fountain Pen 

Ball point pen 

St aplers 

Total Sa le Value 

E 

M aths 

93 

98 

76 

991 

100 

,691 

/~.OU 

26.00 

125.00 

7.00 

52.00 

F G 

Science Tot al 

911 

911 

82 

9·4 

'917 

nl 

4 

0 

3 

14 

1 

, General' 

H 

3491 

363 

334 

349, 

384 

3081 
� 

j OU.OU 

0.00 

375.00 

98.00 

52.00 

1048.75 

j 
~.a .aa 
.cm ~-� 

Number l:i, 

_J_ 

SESSION 6: BASIC CALCULATIONS – MULTIPLICATION 

RELEVANT KNOWLEDGE 

Another math function that is frequently used is multiplication and in this 

Figure 11: Adding Marks 

Figure 12: Multiplication 
exercise you will learn to multiply in a spreadsheet. Create the spreadsheet 

shown in Figure. 

 You will need to use the Multiplication function here. It is used in the 

same way as addition and subtraction. 

o The formula for calculating amount is: Unit 

Price * No. of Units Sold 

o To calculate the amount in cell G3, enter: 

+E3*F3<Enter> 

o Use the Copy – Paste command to enter 

formula in all the other cells. 

 Calculate the Total Sale Value in cell G14. 

 Cells B14 to F14 have been merged and the contents centered. 

 Note that Unit price and Amount has values displayed up to 2 decimal 

places. 

Figure -10: Adjusting 
Decimal places 
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–

L 
1 

2 -
3 

4 

5 

6 

7 

8 
- 9 
-----; 

ij 
fol 

A 

S.No . 

4 

5 

6 

B C 

Name English 

1 Abhas 89, 

2 Anit a 912 

3 Raj a 9'5 

4 St.1bbt.1 84 

5 Priya 94 

6 Gautam 78 

Kmmsn scmKar ,yer M 

Bi/ender Dalal 94 

Geentanj a/i Sharm a 7g 

D E F G H 

Hindi M ath s Scienoe Tot al 

76 ~B 9,1 349, 

82 9,g 9,1 363 

81 76 82 334 

72 9,9 94 349, 

93 100 9,7 384 

89 69 121 3081 
� 

f l ~~' ~4 j,49 l5 /'J6 

9'3 100 97 384 96% 
g9 69 72 308 77% 

Hint: You can do this by using the Increase Decimal and Decrease Decimal under 

the Home tab, in the Number group. You can see them in Figure -10. 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 
Change any of the numbers in the above spreadsheet and see how the 

amounts change automatically 

SESSION 7: BASIC CALCULATIONS DIVISION 

RELEVANT KNOWLEDGE 

Another basic mathematical function is Division. In this exercise you will learn 

Figure -11: Adding Marks 

Figure -12: Division 
how to divide using spreadsheets. Open the spreadsheet created as marks.xlsx 

and calculate the percentage of marks obtained by each student. The final 

spreadsheet should look as shown in Figure -12. 

 You will need to use the Division function here. It is used in the same way 

as addition, subtraction and multiplication. 

o The formula for calculating %age of marks is: (Total Marks) / (4 * 100) 

o To apply the %age symbol, use the % button under the Home tab, in the 

Number group, as shown in Figure -13. 
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Figure -13: Percent icon 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Change any of the numbers in the above spreadsheet and see how the 

marks change automatically 
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� 
/' A I B I C n E I F G H 

5 .No. Ite m Code It e m Name 
Opening 

Re-0e ipts Sold 
Closing 

1 Bal a n oe Balanoe 

2 1 A001 P e n ci l s - H B &00 200 700 300 

3 2 A002 P e nci l s - 1 H 102 175 100 177 

4 3 A003 Cop y - En g li sh 1 7 6 0 105 71 

5 4 A004 Co p y - M ath s 2 1 3 0 1 7 6 37 

6 5 A005 Regi st ers 112 50 1 2& 34 
f-

7 6 A006 Geom etry B o x 35 3 2 10 57 

8 7 A00 7 S e t o f 6 sk e t ch p e n s 75 52 0 127 
f-

9 & A008 Fo u n t ain P e n s 79 36 0 115 

10 9 A009 B a ll p o int p e n s 2 31 17& 100 309 
f-

11 10 A010 Sta p l e rs 1 2 9 5 16 

1 2 
f--=~ 

~ 0 1.1!; 

,!;;opy 

Paste OptToliliS: 

[i] 
Paste ~pecial ... 

~ Jnsert ~ 
_Qelete 

Cl ea r Contents 

fo rmat Cell s ... 

,!;;o lumn W idth ... 

!!i1de 

_!J11 hide 

SESSION 8: INSERT COLUMN AND ROW 

RELEVANT KNOWLEDGE 

Using a spreadsheet, you can modify a worksheet or report created earlier. 

While working a on a spreadsheet you may realize that you need to insert some 

information between two columns. Now do you re-create the sheet all over 

again? In this exercise, you will use the same stock register saved as 

StockRegister.xlsx and learn the solution to such a problem. You will add a 

column which has the Unit Value of each item, after column C. 

a) Inserting a Column: You will add a column which has the Unit Value of each 

item, after column C in Figure -25. 

o Position the cursor near the Column D, as shown in Figure -14, the 

cursor changes into an arrow shape. Click the left button of your 

mouse. The entire column gets selected. 

Figure -14: Insert Column 

o Click the Right Button of your mouse. A menu box 

appears. Select the Insert option (Figure 15). 

o A blank column is inserted in this place. There is a 

ripple movement of data, i.e. the contents of 

Column D move rightwards into Column E and so 

on. 

o This is called inserting a column. 

o You can now enter data in this column and update 

the worksheet. 

Note: The cell addresses in formulas have changed 
Figure 15: Short Cut automatically. 

Menu 
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L: A B C D E F G H I 

S.No. Item Code Ite m Nam e 
Op en ing 

Receipts Sold 
Closing 

1 Bala nce Ba lance 

2 1 AOOl Pencil s - HB 800 200 700 300 

3 2 A002 Penci l s - 11-1 102 175 100 177 

4 3 A003 Copy - English 176 0 105 71 

5 4 A004 Copy - M at hs 213 0 176 37 

6 5 AOOS Regi st ers 112 50 128 34 

7 6 A006 Geom et ry Box 35 32 10 57 

8 

9 ~ 7 A007 Set of 6 sketch p en s 75 52 0 127 

10 8 A008 Fountai 11 Pen s 79 36 0 115 

11 9 AOQ9, Ball p oint p ens 231 178 100 309 

12 10 AOlO Stap lers 12 9 5 16 

13 
-

b) Inserting a Row: Similarly a row can be inserted in a spreadsheet. Position 

the cursor on the Row number on the left hand side, where you want to 

insert a row. The whole row gets highlighted. Right click and insert a row! 

o Add one more item in this spreadsheet by adding a row at row number 

8. 

o The spreadsheet will now look like the figure given below 

Figure -16: Insert a Row 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Practice by inserting more rows and columns in the spreadsheet above 
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A B C D E F G H 

1 

2 S.No. Name Engli sh Hindi M aths Science Tot al 
-

3 1 Abhas 89' 76 93 91 349, 

4 2 Anita 912 82 98 91 363 

5 3 Raja 9'5 81 76 82 334 

6 4 Subbu 84 72 99, 9·4 349, 
-

7 5 Priya 94 9,3 100 97 384 

8 6 Gautam 78 89' ,69, nl 3081 
� 

9 

n A B C D E I F I 
1 S.No. It em ,code It em Name Opening I Closing Bcalanoe -
2 1 AOOl Pencils- HB 800 

-
3 2 AOCl2 Pencils- lH 102 

-
4 3 A003 Copy - Engli s.l 176 -
5 4 A004 Copy - M at hs 213 

-
6 5, A005 Regist ers 112 -
7 6 AOCl6 Geom et ry Bo 35 

-
8 7 A007 Set of 6 s.ket c 75 

-
,9, 8A008 Fountain Pen 79 -
10 9 A009, Ba ll point pe1 231 

-
11 10 AOlO St apl ers 12 

..__ 

SESSION 9: FORMAT CELL AND ITS CONTENTS 

RELEVANT KNOWLEDGE 

Just as in a list that you create on paper or a report you may read, the 

Figure 20: Adding Marks 
information in a spreadsheet can be made more readable by formatting 

(bolding, shading, etc.) a cell and its contents. 

Open a new spreadsheet. Create the spreadsheet as given in Figure 21. It shows 

a partial list of items in a stationery shop. It shows the opening balance and 

closing balance for a month. 

Figure 21: Items in a stationery shop 

We will now change the appearance i.e. format the data as shown in Figure 17. 
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-- --
..ill A B C D E F 

5.No. Item Code It em Name Opening Closing 

1 Balance Balance 

2 1 .ADOl Pen cils- HB 800 

3 2 A002 Pen cils- l H 102 

4 3 A003 Copy - English 176 

5 4 A004 Copy - Maths 213 

6 5 A005 Registers 112 

7 6 A006 Geom etry Box 35 

8 7 A007 Set of 6 sket ch pens 75 

9 8 A008 Fount ain Pens 

10 9 A009, Ba ll point pens 

11 10 AOlO St ap le rs 

12 -
13 

] Hom e 

( Cut 

Insert Pa,ge Layout Formula s 

Calibri • 11 
ill Copy• 

f Format Pa rnter B I !! 

1board r. Fant 

79, 

231 

12 

Data R.-vlew Vi ew 

- - - ~ · I ~ Wrap Text 

i ~ ~~ m Mer!)'I' & Center • 

Alignment Ii 

I 

Figure 17: Formatted Spreadsheet 

Notice that the above sheet has some additional effects to format it. What are 

adjustments and settings which have been done in the formatted spreadsheet? 

These are: 

a) Wrap Text: The text in row number 1 in Figure does not completely fit in 

the cell, as the cell width is smaller than the length of the text. 

o Go to cell A1 and press the left button of the mouse and drag the 

mouse till cell E1 and release the left button. You will see that the cells 

A1 to E1 have been selected. 

Note: When a cell entry overlaps into adjacent cells and there is no 

entry there, the contents are visible. However, the moment and entry 

is made in the adjacent cell, the text gets truncated, i.e. It is there on 

the sheet but not visible. An alternate is to automatically make text 

appear on multiple lines in a cell. This means that you can format the 

cell so that the text wraps automatically using the Wrap Text function. 

o Click on Home tab, and then Wrap Text in the Alignment group as 

shown in Figure -1822. 

Figure -18: Alignment Group 

b) Change Font: 

You have learnt to use Bold, italics and Underline in a word processor. The 

same functions are found in a spreadsheet too. The text in row number is 

Bold. 
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Insert Page Layout j Hom e 

1 Cut 
Cali br i 

~ Copy• 

, Format Painter 

board r. Font 

D 

A 

1 S.No. 

2 

3 

4 

5 

5 

Formulas Oat 

r. 

B C D E F 

Opening Closing 

Item Code Item Name Balance Balance 

1 A00l Pencils - HB 800 

2 A002 Pencils - lH 102 

3 A003 Copy - English 176 

4 A004 Copy - Maths 2l3 

5 A00S Registers 112 

o Go to cell A1 and press the left button of the mouse and drag the 

mouse till cell E1 and release the left button. You will see that the cells 

A1 to E1 have been selected. 

Figure -19: Font Group 

o Now press the icon B under the Home tab. 

o The contents of the selected cells will change to Bold font. 

Similarly you can change the contents of any cell or a group of cells by 

selecting them and using the appropriate icon, B, I or U. 

c) Change Column Width: The text in column number C in Figure does not fit 

into the width of the column. The width of the column C can be increase to 

ensure that the entire text 

entered is visible. 

o Take the cursor to the column 

numbers on top. Position it on 

the line between Column C 

and D, (refer adjacent 

figure). The shape of the 
Figure -20: Change Column width 

cursor changes to a +symbol. 

o Click the left button of the mouse and with the left button pressed, 

drag the + symbol to the right. You will notice that the width of the 

column starts increasing. Once you have the desired width, release the 

left button of the mouse. 

d) Cell Content Alignment: The numbers in Cells A2 to A11 are right aligned in 

that they are center aligned. To achieve this effect, do the following: 

o Go to cell A2. Press the left button of the mouse, keeping it pressed, 

drag the mouse till cell A11 and then release the left button. You will 

see that the cells A2 to A11 have been selected. 
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o Under the Home tab, in the Alignment group, click the symbol for 

Center alignment as shown in Figure 21. 

Figure 21: Alignment Group 

o To align position of the contents of a cell, you need to select that cell 
or the group of cells and then click on the appropriate symbol for Left, 

Center or Right alignment of text. 

e) Create a Border: The data in Figure 27 has Borders around each cell. To 

achieve this effect, do the 

following: 

o Select cells A1 to 

E11.Under the Home tab, 

in the Font group, click on 

down arrow next to the 

icon for borders, as shown 

by the arrow in Figure 

-22. A list of types of 

borders appears. 

o From this list select the 

option for All Borders. 

You will observe that each 

of selected cells get a 

border. 

Figure -22: Adding Borders 
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1.

1 

2 

3 

4 

5 

5 

7 

& 

9 

10 

Paste 

A B C D E F G H 

Marks in HalffY,e1arly Exam 

S.No. N ,ame English Hindi 
1 AbhasKumar &9 75 

2 Anita Goel 92 &2 

3 Raj shekhar Reddy 95 &l 

4 K:ai/ash Sankar Iyer 84 72 

5 Bijen der Dalal 94 93 

6 Geen tanj aJi Sh arm a 78 89 

Home Insert Page layout Formulils 

Cut 

Copy• 

:J Format Painte.r 

Cl I p.b Oil rd r. 

Calibri • 11 

B I :U &, • A . ·-
Font 

M ,aths Sden:ce J:otal 

93 91 349 

98 91 363 

75 82 334 

99, 94 349 

:WO 97 384 

59 72 308 

Data RevicW 

- - -

View / ~• ~Wrap1-
i ~ i ~ I MNge & Center• 

Alrgnmrnt 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Open a new spreadsheet. Create the spreadsheet given in Figure 28 

Figure 23: Formatted Cells 

 Note the following: 

o Marks are displayed center aligned. 
o Total marks are in Bold Font 

o Names of the students are in italics. 

o Contents in row 2 are in Bold and Italics. They are also center aligned. 
o Cells B1 to H2 have been merged and center aligned. 

Hint: For merging the cells and center aligning the contents of the merged 

cell, use Merge & Center shown in Figure -24. 

Figure -24: Merge & Center cells 

 Save the spreadsheet with the name Marks. 
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A B C D t F G H 

S.No. Item Code lt,em Name 
Opening 

Re,ceipts Sold 
Closing 

1 Balanoe Balanoe 

2 1 A:001 Pencils- HB 80 0 2:00 700 300 

3 2 A:002 Pencils- lH 1'02 175 100 177 
-

4 3 A:003 Copy - Engli sh 176 0 105 71 

5 4 A004 Copy - M at hs 213 0 17i6 37 
6 5 A005 Regist ers 112 50 128 34 

7 6 A006 Geom etry Box 35 32 10 57 
8 7 A007 Set of 6 sketch pens 75 52 0 127 

-
9 8 A008 Fmmt ain Pens 79 36 0 115 
10 9, A:009 Ba ll point pens 231 178 100 300 

11 10 A:010 St aplers 12. 9 5 16 

12 

SESSION 10: STOCK REGISTER 

RELEVANT KNOWLEDGE 

A common usage of a spreadsheet is to maintain lists of items along with 

quantities. A stock register is a good example of the same. You will create a 

simple stock register, which is used to keep track of number of units of 

different items kept in a shop or a store. Create the sample shown in Figure 30. 

Figure -25: Stock Register 

 The formula for closing balance is: Opening Balance + Receipts - Sold 

o Enter the formula in cell G2, using a combination of Addition and 
Subtraction. 

o Use Copy – Paste to paste the formulas in all the cells. 

o Format the cells as shown in the sample. 

o Change the name of the sheet to Stock. 

o Save the File as StockRegister.xlsx. 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Prepare a stock register of the grocery items purchased at your home 

Create the spreadsheet as given below: 
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I 
A El C -

1 Item Quantity Pri<ie per Un it 

2 Student Ch r:rirs 123 2:050 

3 Studen t Tables 9 3 1890 

4 Stools 1:96 9185 

5 Te.a.cher Chr:rirs 35 2:6100 

6 J:eacher Tables 45 4300 

7 Computer J:abfes 2.11 6300 

a) Calculate the total amount for each item (Quantity* Price per unit) 

and also the total amount for all items. 

b) Apply appropriate formatting to currency entries (Rs.) and 

numbers. 

c) Adjust the column widths where needed. Insert blank rows 

between column labels and data. 

d) Use alignments, fonts, borders and colors to format the “Furniture 
Details” worksheet. For example, put a border around the title, 
change the color of column headings to red and center all the 

entries in Column B. 

e) Create a header that includes your name and a footer that includes 

current date. Change page orientation to Landscape. 

f) Preview and print the worksheet. 
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SESSION 11: CUSTOMIZING THE INTERFACE 

RELEVANT KNOWLEDGE 

An interface is provided by the software vendor. There is a limited amount of 

customization possible. In this exercise, you will learn to customize the Quick 

Access Toolbar at upper-left corner of the screen. The Quick Access Toolbar is 

shown in Figure 26. 

Figure 26: Quick Access Toolbar 

Note: The Ribbon, which is part of the user interface, is designed to help you 

quickly find the commands that you need to complete a task. Commands are 

organized in logical groups that are collected together under tabs. Because 

each tab relates to a type of activity, such as writing or laying out a page, it is 

not possible to customize the Ribbon without using XML and programming code. 

Things you can't do 

 Add to or rearrange the commands on the Ribbon. 

 Change or remove a command or group on the Ribbon. 

 Add tabs to the Ribbon, unless you use programming code. 

 Change the font or font size used on the 

Ribbon 

Things you can do 

 Minimize the Ribbon to make more space 

available on your screen. 

 Move the Quick Access Toolbar to position it 

below or above the Ribbon. 

 Customize the Quick Access Toolbar to add 

buttons that represent the commands that 

you frequently use. 

On the right side of the Office Button, there is the 

Quick Access Toolbar, as shown in Figure 32. Like a 

Figure 27: Customising 
Quick Access Toolbar 
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'llf'J Undo 
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normal toolbar, the Quick Access displays some buttons. You can right-click the 

Quick Access toolbar. A menu would appear, as shown in Figure 32. If you want 

to hide the Quick Access toolbar, you can right-click it and click Remove Quick 

Access Toolbar. To know what a button is used for, you can position the mouse 

on it. A tool tip would appear. Once you identify the button you want, you can 

click it 

Adding a Button to the Quick Access Toolbar 

By default, the Quick Access toolbar is equipped with three buttons: Save, 

Undo, and Redo. If you want to add more buttons or more options, you can 

right-click the Quick Access toolbar and click Customize Quick Access Toolbar. 

This would display the Excel Options dialog box shown in Figure 28. 

Figure 28: Adding a Button to Quick Access Toolbar 

To add a button to the Quick Access toolbar, on the left list of Add, click an 

option and click Add. After making the selections, click OK 

To remove a button from the Quick Access toolbar, right-click it on the Quick 

Access toolbar and click Remove From Quick Access Toolbar 

The Quick Access Button 

On the right side of the Quick Access toolbar, there is the Customize button 

with a down-pointing arrow. If you click or right-click this button, a menu 

would appear 
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The role of this button is to manage some aspects of the top section of 

Microsoft Excel, such as deciding what buttons to display on the Quick Access 

toolbar. For example, instead of using the Customize Quick Access Toolbar 

menu item as you used previously, you can click an option from that menu and 

its corresponding button would be added to the Quick Access toolbar. If the 

options on the menu are not enough, you can click either Customize Quick 

Access Toolbar or More Commands... This would open the Excel Options dialog 

box. 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1. Minimize the Ribbon to make more space available on your screen 

2. Move the Quick Access Toolbar to position it below or above the 

Ribbon. 

3. Customize the Quick Access Toolbar to add buttons that represent the 

commands that you frequently use 
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35 

1,55 

,fiO 

24 
37

SESSION 12: USE CURRENCY SYMBOLS 

RELEVANT KNOWLEDGE 

When spreadsheets are used in accounting, we often need to show money and 

cash balances using currency symbols. Create the spreadsheet shown in Figure 

29Figure 34. 

Figure 29 

The price given in this sample spreadsheet does not indicate whether it is in 

Dollars or Rupees or in Euros. If you want to display numbers as amounts, you 

need to format the numbers as currency. To do this, apply the Currency format 

to the cells. A currency symbol can be inserted in two ways. These are: 

1. Use the Accounting Number Format button 

The currency formatting option is available 

within the Accounting Number Format button 

under the Home tab, in the Number group. 

o Select Cell E1. 

o Click on the down arrow next to the 
Accounting Number Format button (refer 

Figure 30). 

o A list appears showing some of the 

popular currency symbols. Select Rs. Option. 

o The amount 40 would be displayed as shown in Figure 315. 

o Repeat this procedure for other cells containing the price. 

Figure 30: Accounting 
number format button 

Figure 31 
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Clear Corrti'nts 

Number Rs. 35.00 ;;11,&,l,1 

Accounting Q.edmal places: 12 ~I Date 
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Pie.!, Frnm Drop-dow n List... 

Define Nj!me ... 

& Hyperljnk ... I OK I I Cancel I 

I I 

2. Use the right click 

o Select the Cell in which currency symbol is to be applied 

o Right click the mouse. A short cut menu as shown in Figure 36 appears. 

o Click on the option Format Cells. A Format Cells dialogue box as shown 

in Figure 32 appears. 

o From the Category list provided, choose Currency. 

o Now click on the down arrow on the Symbol box .Available currency 

symbols are displayed. Choose the desired symbol. This symbol will get 

displayed in the cell. 

o 

Figure 36: Short cut menu Figure 32: Dialogue box 

EXEXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1 Create a spreadsheet with the quantity and price of items purchased 

at your home 
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SESSION 13: FORMAT CELL CONTENTS – FONT STYLE AND SIZE 

RELEVANT KNOWLEDGE 

We have already learnt to apply some formatting options. In this exercise we 

will learn some more formatting options. 

Create the spreadsheet given in Figure 33. 

You can change the font (style of writing), for a cell or a group of cells. You 

will learn to do it in two ways, in this exercise. 

1: Using the Icons on the Ribbon 

o On the Home tab, in the Font group, click on the down arrow on the Font 

box (refer Figure 33). A list with various font options appears as shown in 

Figure 34. 

o Select Arial font. You would observe the font (style) of the text in cell C2 
changes (refer Figure 35). 

o Now go ahead and follow the same steps for changing the font style of 

others cells, to what is written in the text. The spreadsheet will appear as 

in Figure 36. 

Figure 33 
Figure 34 
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font s le of contents of a cell or a ou of

Figure 35: Arial Font in Line-1 Figure 36: Different Fonts 

2: Use Short cut menu and the dialog box 

o We will restart with Figure 35 

o Position the cursor in cell C2 and right click the mouse button. Short 

cut menu shown in Figure 37 will appear. 

o Click on Format Cells…. A Format Cells dialogue box appears with the 

Number tab selected by default. 

o Click on the Font tab (refer Figure 38). 
o Choose the font Arial. If needed, use the scroll bar. 
o Repeat this for changing the font of text in all the other cells. 

Scroll Bar Font Tab 

Figure 37: Short Cut Menu 
Figure 38: Format Cell Dialogue Box You have learnt how to change ty gr p 

cells. In a similar way it is possible to change font size of contents of a cell. 
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Create the spreadsheet as shown in Figure 40. Then change font size of the 

contents of the individual cells, as shown in Figure 39. 

Figure 40 Figure 39: Different Font Sizes 

o The steps to do this are similar to what you followed for changing font style 

o The only difference is that now you need to use the option of changing font 

size, instead of the font style 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1. Create any spreadsheet. Now change both the font style and font size 

of the contents of the individual cells. 
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L A B 

1 S.No. Name 

2 1 Ravi Kaul 

3 2 Bij encl er Dalal 

4 3 Radha Sw ami 

5 4 Vikas M aheshwari 

6 5 Vimla Rani 

7 6 Sandhy a Reddy 

8 

C 

Roll No. 

23 

13 

7 

32 

14 

26 

Qelete Cell s .. , 

~ Delete Sheet .Bow s 

W' Delete Sheet£;o lumns 

Delete ~heet 

D E 

Dat e of Birth 
13-Aug-99 

15-Jan-99 

02-Jan-0O 

17- Nov-98 

23-Sep- 99 

19- Dec-98 

SESSION 14: DELETE – COLUMNS AND ROWS 

RELEVANT KNOWLEDGE 

You had learnt to insert a row and a column in an existing spreadsheet. In a 

similar way, you can delete any row of column in a spreadsheet. 

o Select the row or the column to be deleted. 

o Right click the mouse. A short cut menu as shown in Figure 41 appears. 

o Choose the option Delete. The selected row or column will be deleted. 

(Note: The data contained in that row or column will also get deleted. 

1. Select the row / column / cell / cells 

that you want to delete. 

2. On the Home tab, in the Cells group, 

click on the arrow next to Delete. 

3. You will see the options as shown in 

adjacent figure. 

4. Select Delete Cells… to delete selected cells. 

5. Select Delete Sheet Rows to delete the selected row. 

6. Select Delete Sheet Columns to delete the selected column. 

 Create a spreadsheet as shown in Figure 42. 

Figure 41: Short Cut Menu 

Figure 42 

o Delete the column containing the Roll No. 

o Delete the row containing the record of Vikas Maheshwari. 

o Once you have done this, the spreadsheet would like in as shown in 
Figure 438. 
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A B C D 

1 S.No. Name Date of Birth 

2 1 Ravi Kaul 13-A.ug-99 

3 2 Bij ender Dalal 15-Jan-99 

4 3 Radha Sw ami 02-Jan-0O 

5 5 Vim la Ran i 23 -Sep-99 

6 6 Sa ndhya Reddy 19• Dec-98 

7 

Figure 43 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1. Create a spreadsheet. Select two adjacent rows together and delete 

them. Now select two adjacent columns together and delete them. 

2. Create a spreadsheet. Insert three columns together in this 

spreadsheet. Now insert four rows together in this spreadsheet. 
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SESSION 15: SPELL CHECK 

RELEVANT KNOWLEDGE 

Like a word processor, you can check spelling mistakes in a spreadsheet. Create 

a spreadsheet as shown in Figure 4449. This spreadsheet has some spelling 

errors. Make sure that the text you enter has the same or more mistakes. 

Figure 44: Spreadsheet with spelling errors 

o Select the Review tab. In the Review tab there is an option for Spelling, 
as shown in Figure 50. 

Figure 50: Review Tab 

o Click on this option and the spreadsheet software will start checking the 

spellings. If it finds a spelling 

mistake, it will show the 

Spelling: English dialogue box, 

as in Figure 451. 

o You can accept the suggestion 
by clicking on the Change 

option. 

o Or, you can type in the correct 
spelling in the box on top in 

this dialogue box. 
Figure 45: Spelling Dialogue Box 

o Once you have corrected 
this mistake, it will continue checking the rest of the worksheet. 

44 



 

 

     

 

 

 

            

   

 

 

 

 

 

 

 

 

 

        

      

      

 

 

       

       

     

  

 

       

  

     

   

 

 

 

 

 

 

 

     

   
  

Home Inse-rt Prage Layout 

Cut 
Cal:H:i ri· 

- Copy ... 

Format Painte.r 

Cllpboi!rd 

B I II ... EE 
Font 

fonnufa~ D 

r,, 

T 11 T K AT - - -

I EE Tl ~ T~ T 

B-9.ttom Border 

ToQ. Border 

left Border 

Tl Bight Border 

l'!_o Border 

EE 8 11 Borders 

EE Olllt.!_ide Borders 

0 I nick Box Borde r 

_ _!!ottom Double Border 

..... T.b_ick Bottom Bo rder 

_ Top an_g_ Bottom Border 

..... Top and Th ifk Bottom Border 

_ Top and Doyb le Bottom Border 

Draw Bord ers 

liJ' Dra~ Border 

,;fE Draw Border §.rid 

Q_ .!;rase Border 

_! Ljne Co lor 

SESSION 16: BORDER THE CELLS 

RELEVANT KNOWLEDGE 

Under the Home tab, there is an option of applying borders to the cells, as 

shown in Figure 462 

Figure 46: Icon for Border 

o If you click on the down arrow, as 
shown above, a further list of options 

for borders appears, as shown in Figure 

473. 

o To apply the borders to a particular 
cell of a group of cells, first select 

those cells and then apply the border, 

using this option. 

o Create a spreadsheet as shown in 
Figure 484. 

o Use formulas to calculate quarterly 

totals and profit. 

Figure 47: Different options 
for Borders 
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Figure 48: Spreadsheet with Borders 

Use another method to border the cells, as given below: 

 Select the cell of the group of cells (Range), on which you want to apply the 

Border. 

 Right Click. A short cut menu appears, as shown in Figure 495. 

 Choose the option Format Cells… 

 Choose the tab for Border in Figure 5056. 

 Select the appropriate border which you want to apply. 

Figure 49: Short Cut Menu 

Figure 50: Dialogue Box for Border 
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SESSION 17: COLOUR THE CELLS 

RELEVANT KNOWLEDGE 

The method for Coloring cells is similar to that for bordering the cells. Under 

the Home tab, in the Font group, there is an option of applying Colour to the 

cells, as shown in 57. 

Figure 51: Icon for applying Colour 

 Use the same spreadsheet which you created for bordering the cells. 

o Use the Colour option and apply grey colour to some of the cells, so 

that it looks like the spreadsheet in Figure 528. 

Figure 52: Some cells with Colour (Different shades of grey) 

o You can now use other 

colors also, to further 

improve the appearance of 

the spreadsheet. 

Figure 53 
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SESSION 18: MANAGING WORKSHEETS IN A WORKBOOK 

RELEVANT KNOWLEDGE 

When you open a new workbook, it has three worksheets as shown in Figure 

540. The default names given to them is; Sheet1, Sheet2, and Sheet3. Each of 

these worksheets can have data entered in them. When you save the workbook 

in a file, the complete workbook with all the sheets in it get saved. 

Sheet1 is 
displayed. 

Figure 54: Workbook with three worksheets 

 If you click on Sheet2 tab, it 

gets displayed, as shown in 

Figure 551. 

Figure 55: Sheet2 displayed 

Renaming a worksheet: 

You can change the name of 

the worksheet, to give it a 

meaningful name. For example 

if the name of Sheet2 is 

changed to Attendance, and 

name of Sheet3 is changed to 

Marks, it is more meaningful. 

o If you double click on 
the Sheet tab, it 

becomes dark. Now you can type in the new name. (Note: single click 

makes the sheet active and double click for renaming). 

Figure 56: Renamed Worksheets 
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Add a worksheet: 

You can add more worksheets in a workbook. Click the symbol, as shown in 

Figure 573. It adds one sheet. Each time you click it, one sheet gets added. 

Figure 57: Icon for Worksheet addition 

Remove a worksheet: 

You can delete (remove) any 

worksheet from a workbook. 

Select the worksheet to be 

deleted by right-click on its name. 

A short-cut menu pops up. Select 

the Delete option. In the 

workbook, Sheet1 has been 

deleted by following these steps, 

as shown in Figure 584. Figure 58: Workbook after Sheet1 is removed 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1. Rename a worksheet. 

2. Add a worksheet 

3. Remove a worksheet 
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SESSION 19: PRINT A WORKSHEET 

RELEVANT KNOWLEDGE 

The method for printing a worksheet is almost similar to the one you used for 

printing a document in a word processor. 

1: Print a worksheet - with default settings 

Open any of the workbooks created be you in the earlier exercises. 

1. Select the [1] File  [2] Print 

2. The worksheet will be printed. Do make sure that you have a printer 

connected to your computer. 

Note: To print just a selected portion, select the cells to be printed and then 

follow step 1. 

2: Print a worksheet – Using Page Layout 

This above specified method of printing is useful, when the data in the 

worksheet is not large and can easily fit into one page. In case the file has large 

amount of data, which will get printed on multiple pages, then you can adjust 

the Page Layout and Print settings, using the options available in Page Setup 

under the Page Layout tab in the ribbon. 

Figure -59: Page Layout Ribbon 

a) Margins: This option allows you to change the margin settings for Top, 

Bottom, Left and Right Margins in the printed page. 

b) Orientation: Using this option you can change the orientation of printing 

between Portrait and Landscape. In portrait mode, the height of the paper 

is more than the width. 

c) Size: This option allows you to change the size of the paper to be used for 

printing. Most of the normal printing is done using either A4 or the Letter 

sized paper. 
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d) Print Area: This option is used, when you do not want to print the complete 

worksheet, but want to print only a part of the worksheet. In this case: 

o First select the Range of cells from the worksheet which have to be 

printed. 

o Select the option Print Area. Then Select the option Set Print Area. 

e) Page Setup: The Page Setup dialog box (refer Figure 606) can also be 

opened by clicking on the Dialog Box Launcher symbol on the bottom 

right hand corner of the Page Setup group in the Page Layout tab (refer 

Figure -59). You can then select the appropriate options for setting. 

Figure 60: Page Setup Dialogue Box 

EXERCISE 

Perform the following activities till you are confident: 

S.No. Activity 

1. Create your class time table using a spreadsheet. Apply borders, 

appropriate font style, font size, column widths, content alignment, 

etc. to make it appear attractive. Print this time table. 
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